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LESSON 2 - NAV IGAT ION

STEP BY STEP — LAUNCH INEIGHT ESTIMATE VIA ON-PREMISE

1. From the Windows desktop, locate the InEight Estimate shortcut icon.

2. Double click on the icon, or right click and select Open.

If you cannot find the InEight Estimate shortcut icon, you can also launch InEight
Estimate from the Windows Start menu.

InEight Inc.  |  Release 21.10 Page 7 of 200

Estimate Training Manual



STEP BY STEP — ARCHIVE AND RESTORE A JOB

1. Click File to open the Backstage View.

2. Select Archive / Restore.

l Several options appear for archiving and restoring your jobs and library

3. Select Archive Job.

l The Job Register appears

4. Select the Training Job, then click OK.

5. When prompted to include attachments, click Yes.

l The Save As window appears

6. Browse to where you want to save the job, then click Save.

7. To restore the job, select Restore Job Archive from the Archive / Restore page of the Backstage
View.

8. Browse to the archived job and select it.

9. Click Open.

l If the job already exists, a prompt will appear asking if you want to overwrite it

l To overwrite it, select Yes

l If you select No, you will be prompted to save it under a new Job Code

Page 8 of 200 InEight Inc.  |  Release 21.10

Estimate Training Manual



STEP BY STEP — OPEN A JOB FOLDER

1. From the Backstage view, under the Open a recent Job section, double click on your job.

2. The job folder opens by default to the Cost Breakdown Structure Register.

You can change the default form that opens when you start up a job. From the Backstage view,
click on Settings to change the Job Startup > Start Page settings.
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STEP BY STEP — OPEN FORMS

1. Click on the Setup tab.

2. In the Initialize section of the Setup tab, click on the drop-down menu for Job Properties.

3. Select Overview to open the Job Properties form.

l Notice that each form opens in its own tab within the active job folder

l You can tab between these forms as you are working in InEight Estimate
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l Once you are in a register, the Actions and More Actions tabs are available to you. The options
available are contextual to that register
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(missing or bad snippet)
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STEP BY STEP — MOVE COLUMNS

1. In the CBS, click on the Currency column header and drag the column to the left, dropping it to
the right of the Description column.

2. Hide the Optional Code column by dragging the Optional Code column header down until a black
X appears, then let go.

l The Optional Code is now hidden from view

l To unhide a column, right click on any column header and select Column Chooser; a
Customization window appears, which contains all the hidden columns in that register

3. Find the column you want to unhide and drag-and-drop it to the location where you want it to
go.
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l You can also unhide a column using the Go To Column feature

4. Right click on a column header and select Go To Column.

5. Click on the drop-down menu and select the column you want to unhide.
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6. Click OK.
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STEP BY STEP — SORT COLUMNS

You can sort on any column by clicking once on the column header.

1. In the CBS Register, click on the Total Cost (Forecast) column to sort the column in ascending
order (e.g., 1 to 10, A to Z).

2. Click the Total Cost (Forecast) column a second time to sort in descending order (e.g.,10 to 1, Z
to A).

Use Ctrl-click to unsort a column and reset it to its original state.
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STEP BY STEP — FILTER COLUMNS

1. In the CBS, hover over the Unit of Measure column header for the filter icon to appear.

2. Click on the filter icon in the Unit of Measure column to select a filter value.

l From the filter list, you can select any of the values defined for that column or you can use
one of the predefined values (Custom, Blanks, Non blanks).
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3. Make your selection, then click Close.

4. To clear the filter, click on the red X at the bottom of the form or click on the filter icon on the
header of the column you filtered and select (All), then click OK.
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STEP BY STEP — FILTER EDITOR

1. In the CBS, hover over the Unit of Measure column header for the filter icon to appear.

2. Click the Filter icon in the Unit of Measure column to select a filter value; select the desired
UoM.

3. Select the Filter Editor button, and the Filter Editor data box appears.

l By default, an And statement is created with a Begins with operator and a blank
value.

4. Select your preferred operator and enter in your preferred value.

5. To add additional And/Or statements, select the word And in the top left corner. A drop-down
appears.

6. Choose which And/Or statement to add and then select the Preferred Operator.

7. Enter in your Preferred Value to complete your additional statement.

8. Click OK.

l Select the X to delete a single statement.

9. Select the And statement in the top left corner to begin clearing all And/Or statements.

10. From the drop-down, select the option Clear All.

11. Once done, select Apply and then click OK.
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STEP BY STEP — GROUP COLUMNS

1. From the CBS register, group the Unit of Measure column by dragging it into the grouping area
(where it says “Drag columns here to group”).

l Notice that the cost items in the register are now grouped together by their units of
measure, and each group of cost items is subtotalled by costs, hours, quantities, etc.

2. To ungroup, right click in the grouping area and select Clear Grouping

l The column returns to its original location

You can group by more than one column to have multiple grouping levels.
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STEP BY STEP — CREATE A SAVED VIEW

1. In the CBS register, click on the Saved Views drop-down menu and the Save disc icon appears.

2. Click on the Save disc icon.

l The Save Current View window appears

3. Enter the View Name, then select OK.

l The new view displays in the drop-down menu

Saved views are user-specific; you will only see your own saved views when you are
logged in.
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LESSON 3 - L IBRARY SETUP

STEP BY STEP — CREATE A LABOR RESOURCE

1. From the Library landing page, on the Setup tab, click on Resource Rates from the Master
Resources section.

l The Library Resource Rate Register opens

2. Select the Labor tab.

3. Right click on any row header and select New.

l A new Labor Rate Record displays

4. In the Code field, type L + [your initials].

5. Press the Tab key.

6. Fill in the Description field.

7. Click on the resource’s Setup tab and select Standard Labor Rate File from the Resource File
drop-down list.

8. Select a location for the Geographic Area.

9. SelectWage Zone A for Wage Zone.

10. Select a labor type for the Organizational Category.

11. For Tag 1, select a code.

12. For Tag 2, select a code.

13. On the Charge Rate tab, enter a dollar value for your Labor Base.

14. Expand Labor Burden and under Labor Fringes, type in a dollar value for Pension and
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Subsistence.

15. Define an overtime and double-time rate for the resource. Select the checkbox for Use Base
Wage Factors for Scales 2 and 3.

16. Set the Scale 2 Factor to 1.50 x Base Wage and Scale 3 Factor to 2.00 x Base Wage.
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17. Click OK, to close the record.
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STEP BY STEP — CREATE A RENTAL EQUIPMENT RESOURCE

1. Open the Library Resource Rates Register.

2. Select the Rented Construction Equipment tab.

3. Right click on any row header and choose New; a new Installed Rented Equipment Rate Record
displays.

4. In the Code field, type RECR + [your initials], then press Tab.

5. In the Description field, type Crane 110 Ton.

6. Click on the resource’s Setup tab and select Standard Rental Rate File from the Resource File
drop-down list.

7. Select a resource from the Organizational Category drop-down list.

8. Move back to the Charge Rate tab to follow the step by step on the next page.

Page 26 of 200 InEight Inc.  |  Release 21.10

Estimate Training Manual



STEP BY STEP — NON-HOURLY RATE CALCULATOR

1. Refer back to your last entry's rate amount. Under Non-Hourly Period Charge Rates on the right,
check the Calculate Non-Hourly Period Charge Rates checkbox.

2. On the resulting prompt, click OK.

3. In the Period field, selectWeekly.

4. In the Amount Per Period field, type in a number value.

5. Type in a number of hours in the Hours Per Period field.

6. Click OK to close the record.
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STEP BY STEP — CREATE AN INSTALLED MATERIAL RESOURCE

1. Select Resource Rates from the Library landing page.

l The Resource Rate Register displays

2. Select the Installed Material tab.

3. Right click on any row header and select New from the drop-down menu.

l A new Installed Material Rate Record displays

4. In the Code field, typeMGBP + [your initials], then press Tab.

5. In the Description field, type Brick Pavers.

6. Select a unit of measure from the Unit of Measure drop-down list.

7. On the resource’s Setup tab, under Resource File select Standard Material Rate File.

8. On the Charge Rate tab, expand Materials and enter a number valuein the Installed Materials
Amount field.

9. Click OK to finish adding this resource.
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STEP BY STEP — CREATE A RESOURCE ASSEMBLY

1. From the Library landing page, under the Master Resources section of the Setup tab, select
Resource Assemblies.

l The Resource Assembly Register is shown.

2. Right click on any row header and select New from the drop-down menu.

l A new Resource Assembly Record is shown.

3. In the Code field, type CEXC + [your initials] as the unique code for the assembly.

4. Add a description in the Description field.

5. In the Assembly Details register at the bottom of the screen, click in the Resource Code column
in the first blank row, and then select the Resource icon that appears in the cell.

6. On the Labor tab of the resulting register, select the resource with the Description: LL2Laborer
and click OK to add this resource to the assembly.

7. Add two additional resources.

You can use the Ctrl and Shift keys to select multiple resources at once.

8. Click OK to save and close the new assembly.
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LESSON 4 - PROJECT SETUP

CREATE A NEW JOB FROM SCRATCH

1. From the Backstage view, select to create a new job from scratch.

2. In the New Job dialog box, click in the Core Project field to select a Platform job from the list.

3. Modify the Code field as needed.

4. Enter a description of the job in the Description field.

5. Determine if you want to select the Auto-Update Job in Connected Analytics check box.

6. Click OK to create the new project.
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STEP BY STEP — SET UP JOB LEVEL SECURITY

1. On the Job Properties > Security tab, select the Restrict access to this Job… check box.

l Notice the checkbox to “Allow ALL users with Bid Wizard access to use this job as a source”
is checked by default. Make sure to keep this checked as well

2. Click the Add Users / Groups button to add users.

3. In the Select Users or Groups dialog, type the email addresses for those that need access and
then click OK.

l If you don’t know the email address, you can type the name of the user, and click the
Check Names box to find the appropriate user

l The job can now only be opened by those listed under Users allowed in this job
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STEP BY STEP — SHIFT RATE CALCULATOR

1. On the Job Properties > Cost Basis tab, select the Shift Rate Calculator button.

2. For Shift 1, type a number value of hours in theMonday through Friday Work Hours fields.

l You can enter up to three shifts for the project

3. For Shift 1, type a number value of hours in the Scale 1 fields.
l Scale 1 will be your regular time and Scale 2 will be any overtime

4. Enter a number value for hours in the Scale 2 fields (just Monday through Friday).

5. For Shift 2, type a number value for hours as you did above in Step 3.

6. Click OK.
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l Now you have a blended shift arrangement, and your labor rates are a blend of
64.18% straight-time and 35.82% overtime
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STEP BY STEP — IMPORT FILTERED RESOURCES

1. In your Job, go to the Job Properties > Cost Basis tab, select the Labor Rate resource type.

2. Under Resource File Description, select Standard Labor Rate File.

3. In the Geographic Area, select an Area.

4. For Wage Zone (Work Center), select aWage Zone.

5. For Organizational Category, select All.

6. Follow the same steps for the remaining resource types.

7. Select the Import Filtered Resources button to bring your selected resources into the job.

l For this example, we'll select the following filters for the Labor resource type:
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STEP BY STEP — ENTER FUEL COSTS

1. In your job, open the Job Properties > Fuel Cost tab.

2. In Cost Per UM column, enter a dollar amount into the following:

l Diesel

l Gas & Gasoline

l Off Road Diesel

3. Currency should read U.S. Dollar and UM should read Gallon.
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STEP BY STEP — CREATE A PAY ITEM

1. Open your job and select Setup tab >Pay Item & Proposal from the InEight Estimate landing
page.

l The Pay Item & Proposal Register displays

2. In the Pay Item Number column, in the first blank row, type a number value.

3. Use the Tab key to move to the Description column and type a description.

4. Leave the Pay Quantity at 1.00 and change the Unit of Measure to LS (Lump Sum).

l The Forecast (T/O) Quantity will auto populate to match your pay quantity, but can be
changed later

l You can tab to the next row to create additional pay items if needed
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LESSON 5 - D IRECT COSTS

STEP BY STEP — ADJUST TAKE-OFF QUANTITIES

1. From the Estimate tab, select Cost Breakdown Structure (CBS).

2. In the Forecast (T/O) Quantity column, the Forecast (T/O) Quantity is brought over from the Pay
Item & Proposal Register, but here you can adjust it if needed. Practice adjusting the Forecast
T/O quantity of one of your cost items.

l For this example, we’ll change Clearing and Grubbing to 15.00 Acre and Excavation to
40,000 CY.
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STEP BY STEP — CREATE A SUBORDINATE COST ITEM

1. From the Estimate tab, select Cost Breakdown Structure (CBS).

2. Right-click on a cost item and select Insert Subordinate.

l This creates a new subordinate cost item below your selected cost item

3. For the subordinate cost item, enter a description.

4. Add a quantity and select your Unit of Measure.

l For this example, we’ll insert a subordinate under Clearing & Grubbing for Clearing

You can create a subordinate at the same level, by right clicking on an equal-
level cost item and selecting Insert.
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STEP BY STEP — DEFINE A PLUGGED COST

1. From the Estimate tab, select Cost Breakdown Structure (CBS).

2. Right-click on the row header for a cost item and select Open.

3. In the Cost Source drop-down field select Plug.

4. In the left section of the cost item, select the Plug tab.

5. Click in the Unit cost or Total cost field for a cost category and type in a Numeric Value.

l For this example, on the Mobilization cost item, we’ll add $10,000 in the Total Cost field
for both Labor and Owner Equipment.
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STEP BY STEP — ADD COST DETAIL

1. From the Estimate tab, select Cost Breakdown Structure (CBS).

2. Right-click on row header for a cost item and select Open.

3. Select the Detail tab.

4. A blank row is available to define your costs. With your cursor in the code field, click the
Resource Selection icon to open the Resource Selection Register.

5. Select a resource tab (e.g., Labor).

6. Select a resource.

7. Select OK.

8. Repeat the steps to add additional resources as needed.

9. Click in each resource’s quantity field to change their quantity as needed.

10. From the lower-right section of the form, select the Production tab.

11. Type a numeric value in the Days field, then press Tab.

12. Click OK to close the record.

l For this example, we’ll add cost detail to the Clearing cost item, adding the following labor
and equipment resources and production value:
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STEP BY STEP — DEFINE COST DETAIL BY ADDING AN ASSEMBLY

1. From the Estimate tab, select Cost Breakdown Structure (CBS).

2. Right-click on the row header for one of the cost items and select Open.

3. Select the Detail tab.

4. With your cursor in the Resource Assembly field, click the Resource Assembly Selection icon to
open the Resource Assembly Selection Register.

5. Select an assembly, then click OK.

6. Because this crew includes duration-based resources, you need to enter a Production value.
Select the Production tab.

7. Type a numeric value in one of the production fields (e.g., UoM/day), then press Tab.

l For this example, on the Grading cost item, we’ll add a Grading assembly with a
production value of 1 Acre/Day.
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STEP BY STEP — ADJUST SHIFT ARRANGEMENTS

1. From the Estimate tab, select Cost Breakdown Structure (CBS).

2. Right-click on the row header for a cost item and select Open.

3. Select the Cost Item Setup tab in the lower-right portion of the form (the tab name may be
abbreviated).

4. In the Default Pay Rules data block, adjust your Composite Wage Scale as needed.

5. Under the Composite Wage Scale, adjust the number of hours and paid as needed

6. In the Default Shift Arrangements data block, make changes as needed.
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l For this example, we’ll make the following changes on the Clearing cost item:

l Composite Wage Scale – 80% Scale 1, 20% Scale 2.

l For every 10 hours worked, pay 10 hours.

l Default Shift Arrangements – Change Work Hours per Shift to 10.
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STEP BY STEP — SUSPEND A COST ITEM

1. On the Cost Breakdown Structure (CBS) Register, select a cost item.

2. Right click on the selection and select Toggle Suspended from the menu.

l You can also select Toggle Suspended under the Edit section of the Actions tab up above

l You can also suspend cost items by checking the Suspend checkbox on the Cost Item Setup
tab of a cost item record

l If a superior cost item is suspended, its subordinate cost items are automatically
suspended as well

l The costs associated with these cost items will no longer contribute to the estimate
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STEP BY STEP — UNSUSPEND A COST ITEM

1. On the Cost Breakdown Structure (CBS) Register, select a cost item.

2. Right click on the selection and choose Toggle Suspended.

l You can also select Toggle Suspended from the Edit section of the Actions tab

l You can also unsuspend cost items by unchecking the Suspend checkbox on the Cost Item
Setup tab of a cost item record
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LESSON 6 - IND IRECT COSTS

STEP BY STEP — ADD JOB MANAGEMENT & EQUIPMENT COSTS

1. In your job, from the Estimate landing page, select the Cost Breakdown Structure (CBS).

2. Double-click on the row header of the Job Management & Equipment indirect cost item.

3. Add resources by clicking in the Code column and selecting the Icon.

4. Select the Production tab.

5. Enter a production value.

6. Click OK to close the record.

l For this example, we'll add the following resources and production:
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STEP BY STEP — ADD GENERAL EXPENSE COSTS

1. From the Estimate tab, select the Cost Breakdown Structure (CBS).

2. Right-click the row header of the General Expense row header and select Open.

l You could add existing resources here, but in this case, you will create an ad hoc resource.

3. In the first blank row, enter a description, quantity and unit of measure.

4. Click on (highlight) that row, and then click the Resource Employment Breakdown tab.

5. Type a numeric value in the Undefined Supplies cost category.

6. Click Ok to close the record.

l For this example, we’ll add General Office Supplies, 1 Lump Sum, $1,000 in the Supplies
category.
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STEP BY STEP — DELETE EXISTING DEFAULT DEPENDENT COST
ITEMS

1. From the Estimate tab, select Cost Breakdown Structure (CBS).

2. Select an Indirect Cost Item by clicking on its row header.

3. Press and hold the Ctrl or Shift key to select multiple indirect cost items.

4. Right-click on the selection and select Delete.

5. Select Yes to confirm you want to delete the selected cost items.
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STEP BY STEP — DEFINE PRIME BOND

1. From the Estimate tab, select Cost Breakdown Structure (CBS).

2. Right-click on the row header for any cost item and insert Dependent cost Item.

3. On the resulting Attention prompt, select Based on Bond Table.

4. Click OK.

5. Right-click on the Prime Bond row header and select Open.

6. Use the Table Name drop-down to choose a table (e.g., Example: General Construction).

7. Click OK to close the record.
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STEP BY STEP — DEFINE A PRICE % ADD-ON

1. From the Cost Breakdown Structure (CBS) Register, right-click on the row header for any cost
item and select Insert Dependent Cost Item.

2. On the resulting Attention prompt, select Based on Job’s Price.

3. Click OK.

4. Double-click on the Price % Add On row header to open the record.
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5. The Price % Add-on Record opens to the Description tab. Type a description in the Description
field and enter a numeric value for rate.

6. Click OK to close the record.

l For this example, we’ll enter a description of Office Overhead and a rate of 4%.
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STEP BY STEP — DEFINE A DIRECT COST ADD-ON

1. From the Cost Breakdown Structure (CBS) Register, right-click on the row header for any cost
item and select Insert Dependent Cost Item.

2. On the resulting Attention prompt, select Based on Direct Costs.

3. Click OK.

4. Double-click on the Direct Cost Add-On row header.

5. On the Description tab, type a description in the Description column.

6. Press the Tab key (you can define additional rows for other add-on costs as needed).

7. Click on the Dependency tab to see what contributes to your subject cost.

8. For this activity, leave the default (lower) button selected.

9. On the Cost Breakdown tab on the right, add an add-on rate (percentage) or cost at any of the
cost category levels you need.

l This updates the Total Cost (Forecast) of your item on the Description tab

10. Click OK to close the record.

l For this example, we’ll create a new Direct Cost Add-On, giving it a description of Small
Tools with a rate of 10% on the Labor cost category
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STEP BY STEP — ADD USER-DEFINED INDIRECT COST ITEMS

Let’s walk through a specific scenario for this step by step.

1. At the bottom of your CBS, create an indirect cost item called Job Overhead with a Forecast
(T/O) Quantity of 1 and Unit of Measure of Each.

2. Add two subordinates under the new cost item named Job Trailer and Utilities. Job Trailer is 1
Each but change Utilities to 1 Lump Sum.

3. Open the Job Trailer cost item by double-clicking on the row header.

l Assuming there is no Job Trailer in our Resource Rate Register, you will create this
resource “on the fly”.

4. In the Detail grid, click on the Resource Register icon in the Code field as if you were going to
select from the Resource Rate Register.

5. On the Resource Rate Register, click the Rented Construction Equipment tab.

6. Right-click on one of the Line Items and select New to add a new resource.

7. Enter a Resource Code of RJT and description of Job Trailer.

8. In the Amount column enter 25 for the Rented Equipment category.

9. Click OK to close the Resource Rate Record.

10. Select the new resource you created, then click OK to return to the cost item record.

11. On the cost item record, adjust the Job Trailer quantity to 2.

12. On the Production tab, enter 70 days.

13. Click OK to close the record.

14. On the CBS register, select the Utilities cost item by double-clicking on the row header.

15. Create an ad hoc resource on this cost item called Electricity, which will be 1 Lump Sum.

16. Finally, go to the Resource Employment Breakdown tab and enter 1500 in the Custom Category1
row.
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17. Click OK to close the record.
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LESSON 7 - F INAL IZE EST IMATE

STEP BY STEP — ADD PROFIT AS A PERCENTAGE OF TARGET PRICE

1. Open your job.

2. Select the Price tab.

3. Select Price Breakdown Structure (PBS) from the Overhead and Profit section.

4. On the Target Profit row, enter a numeric value in the % of Target Price column; press Tab.

l For this example, we’ll add 10% for the Target Profit.
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STEP BY STEP — MODIFY THE DIRECT COST MARKUP RECORD

1. On the PBS form, double-click on the Direct Cost Markup row.

2. In the record, overwrite the Default entry with Direct Cost Markup in the description field.

3. In the Rate column on the Dependency Cost Breakdown, add a numeric value in Labor, Owned
Equipment, Materials and Fees categories. Then reset other categories back to 0.

4. Click Ok to save your changes and return to the PBS.

5. Click the Refresh Summary Data button to see the changes reflected.

l For this example, we’ll add a rate of 15 for Labor, 10 for Owned Equipment, 8 for Materials, and
2 for Fees, then zero out all other categories.
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STEP BY STEP — DEFINE PRICING MANUALLY

1. From the Estimate landing page, select the Price tab.

2. Select Pay Item & Proposal from the Pay Items section.

3. Select a Pay Item row.

4. In either the Unit Price (current), Total Price (current), or % Margin field of a pay item, type a
numeric value.

For this example, we’ll do the following:

l Mobilization pay item – change Total Price (current) to $20,000.

l Clearing & Grubbing pay item – change % Margin to 5%.
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STEP BY STEP — USE AUTOPRICE TO BALANCE AND HIT THE
TARGET TOTAL

1. Open the your job in Estimate.

2. From the Estimate landing page, select the Price tab.

3. Click on Pay Item & Proposal to open the Pay Item & Proposal Register.

4. On the Pay Item & Proposal Register menu, choose Actions > Balanced Bid > Hit Target Total.

5. Review the Proposal Recap and see that the Variance is now $0.00. Now that the job is balanced,
you can see that the Current Price and the Target Price are the same, indicating that the costs
and profit are spread proportionately over your pay items.
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STEP BY STEP — UNBALANCE HIT TARGET TOTAL

1. You may encounter overrun and/or underrun items in the Pay Item & Proposal Register of your
job.

2. If you do, highlight the row for each item to view it’s current balanced item recap.

3. On the Pay Item & Proposal Register menu, choose Actions > Unbalanced Bid.

l You will see the changes reflected and how the profit was spread to your overrun and
underrun items
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l In the example shown, highlighting each item will show that all your overhead and
profit from Excavation was put onto Clearing & Grubbing.
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STEP BY STEP — LOCK PRICE

1. Select the Lock Price checkbox on an item's row.

2. After making further adjustments in the next step by step, you will return to the Pay Item &
Proposal to rebalance.

l You can continue to adjust at previous levels aside from solely in the Pay Item & Proposal
Register

l For example, you could make a last-minute adjustment in the PBS or CBS. You can make
adjustments anywhere, but for this example an adjustment will be made in the Direct Cost
Add-On record at the CBS level
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STEP BY STEP — MAKE LAST MINUTE BID ADJUSTMENTS

1. With your job open, select the Estimate tab.

2. Click on Cost Breakdown Structure to open the CBS.

3. Double click on the row header to open the Direct Cost Add-On dependent cost item record.

4. Under the Description tab on the left, click in the blank row under the Description column.

5. Type in a description.

6. Make the adjustment by typing a numeric value in the Cost column of the Materials Cost
category under the Cost Breakdown section on the right.

l To make a cut, enter a negative value, i.e. -1000

7. Press the Tab key, and your adjustment will be reflected on the left-hand side.

8. Finally, return to the Pay Item & Proposal.
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9. On the Actionsmenu, select Balanced Bid > Hit Target Total.

10. An Auto Price Warning may display, informing you of rounding variances. After reading the
details, click the Close button.

l Note on the proposal recap that a variance may still exists because there are limited
number of pay items to spread the rounding error over

l Note that the locked item did not adjust, but the other pay items were updated
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l Note that you can overwrite locked items for spreading your price by checking the
Overwrite Locked Pay Items option on the Actions menu
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LESSON 8 - QUOTE MANAGEMENT

STEP BY STEP — CREATE AND PUBLISH AN RFQ

This exercise walks through a specific example using the Training Job.

1. From the Estimate landing page, select the Quote tab.

2. Select Request for Quote (RFQ).

3. From the Actions tab, click on the New icon to create a new RFQ.

4. Select Create RFQ from Quote Group Tag(s), leaving the checkboxes checked to only show
quote groups and resources that are being used.

5. Select the Aggregates quote group from the right panel.

6. Click OK.

7. In the Response Deadline Date field, select a date two weeks from today, and for the Response
Deadline Time, type a time stamp (e.g. 11:00 am).

8. Select the Terms & Conditions tab.

9. Create and type Prices are good for the duration of the contract in the Buyer’s Special Terms &
Conditions field.

10. Type in All items to be delivered to jobsite by supplier’s trucks in the RFQ Instructions field.

11. Select the Vendor Companies tab and click in the first blank row in the Company Name column.
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12. Click on the Address book icon, and then select the following example vendors:

l Example Vendor 1: Pat Roberts

l Example Vendor 2: Stan Mark

l Example Vendor 4: Lester Slim

13. Click OK.

14. Make sure Publish to File is checked for all vendors.

15. Uncheck Publish by email for each vendor.

16. Select the sellers to whom you want to send the RFQ.

l Word opens the file automatically for you to review; and from here you can either print it
or send it in an email as an attachment
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l

17. On the Actions tab of the record, select Publish to create your RFQ document.

18. Select the folder to publish to.

19. Click OK to save the RFQ Record.
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STEP BY STEP — CREATE A QUOTE FROM RFQ

This exercise walks through a specific example using the Training Job.

1. From the Estimate landing page, select the Quote tab.

2. Select Request for Quote (RFQ).

3. Open the RFQ record for which you’ve received quotes.

4. Select the Vendor Companies tab and select the vendors for whom you need to create quotes.
In this case, select all the vendors.

5. From the Actions menu, select Create Quote.

6. Click OK on the Quotes created prompt.

7. Close the RFQ record and the RFQ register.
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STEP BY STEP — ENTER QUOTE DETAILS

This exercise walks through a specific example using the Training Job.

1. To open the Quote Register, select Quote from the Estimate landing page.

2. Select Quotes from the Quote Management section.

3. Open the Aggregates Quote Record for Vendor 1 – Pat Roberts.

4. On the Resources tab, make sure No Split is unchecked for all items.

5. Also on the Resources tab, enter the following unit prices:

Resource Code Description Unit Price

MBR Aggregate Base Rock $8.00

MDIRTB Dirt Class B $6.00

6. Click OK to close the Quote Record.
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STEP BY STEP — CREATE A MULTI-PACKAGED QUOTE

1. From the InEight Estimate landing page, select the Quote tab.

2. Click on the Quotes icon under Quote Management.

3. Double click on an item (e.g. Pipe Materials).

4. In the Description field, type in or replace the description.

5. In the Contact field, select a contact.

6. Click OK

7. Select the Cost Items tab on the left side of the screen.
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8. Add a cost item under Cost Items.

9. Then, add another cost item under Cost Items.

10. On the Packages tab, enter the following 2 new records:

l Code: P1

l Description: On Site

l Amount: $200,000

l Code: P2

l Description: Off Site

l Amount: $300,000
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11. Type in P1 under Package for cost item 7.

12. Type in P2 under Package for cost item 8.

13. Select OK.

14. Under the Quote Comparison and Award ribbon, select Cost Items.

15. Under Quote Groups, select Pipe Materials.

l Quote Comparison and Award shows the newly created quote with the associated
package quotes.
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l The Package Price can quickly be modified in the Quote Comparison and Award form by
selecting the Edit Package action in the Actions tab or by using the right click context
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menu.
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STEP BY STEP — DUPLICATE AN EXISTING QUOTE

1. From the InEight Estimate landing page, select the Quote tab.

2. Select the Resources icon under Quote Comparison & Award.

3. Highlight any row under the Quote column you want to duplicate.

4. Select the Actions tab.

5. Under the Quotes section, select the Duplicate Quote icon.

l The resources and prices from the quote you previously selected have been copied
into a new Quote Record.

6. From the Header block, enter in any missing information.

l The information listed in the Header block will not copy over to the duplicated quote.

7. Enter additional Cost Items in the Quote tabs data block.

l Check the default data blocks for any information you want to add to your duplicate
quote.
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8. Once done, click OK.

Page 80 of 200 InEight Inc.  |  Release 21.10

Estimate Training Manual



STEP BY STEP — ADD THE NOTES SECTION TO QUOTE COMPARISON
& AWARD FORM

1. From the InEight Estimate landing page, select the Quote tab.

2. Select the Resources icon under Quote Comparison & Award.

l Notice the absence of the Notes section. This is the default option until you follow the
next steps.

3. Select the Actions tab.

4. From the View section, select the Configure Totals icon.

5. Select the check box in the Visible column for the Notes caption.
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6. Select OK.

l The Notes section displays on the Quote Comparison & Award form.
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STEP BY STEP — COMPARE AND AWARD QUOTES

This exercise walks through a specific example using the Training Job.

1. From the main Estimate landing page select Quote>Quote Comparison & Award.

2. Select Resources on the Quote Comparison & Award ribbon.

3. Under Quote Groups, select Aggregates.

4. Review the quotes to determine the lowest bidder:

l MDIRTB is marked as Free for Example Vendor 4 and their quote is not splitable.

l Vendor 2 Stan Mark did not give a quote for MDIRTB, so a substitute value is being used.

5. Vendor 2 has the lowest comparable amount for MBR Aggregate Base Rock and Vendor 1 has
the lowest comparable amount for MDIRTB, so you decide to award each respectively. Award
each of them by right-clicking on the value and selecting Award.

6. On the attention prompt click Yes.
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STEP BY STEP — MANAGE AND AWARD SCOPE ITEMS

This exercise walks through a specific example using the Training Job.

1. Click the Quote tab and then click the Quotes icon to open the Quote register.

2. Open the Quote Record for HD Engineering Group and enter a Unit Price of 3,500 which is based
on the quote you received.

3. Select the Special Terms & Conditions tab and select the Seller's Special Terms & Conditions
radio button.

4. Assuming the HD Engineering is excluding certain scope items from this quote, click on the
Included checkbox to exclude (uncheck) the following scope items:

l Surveying and Layout

l Painting Electrical Equipment

l Temporary Power and Lighting

5. Type 150 in the Amount field for Electrical Equipment.

l Notice how the 3 scope items you just excluded are now added to the Special Conditions total
for the quote.

6. Click Next to move to the other Quote record for Architectural Designs.

7. Enter a Unit Price of 3,700.

8. Press Tab to move to the Special Terms & Conditions tab and select the Seller's Special Terms &
Conditions (at right) radio button.

9. Uncheck the inclusions checkbox for Surveying and Layout.

10. Add the amount 500.

11. Click Ok.

12. Select the Quote tab.

13. Open the Quote Comparison and Award form, and select the Cost Items tab.

14. Under Quote Groups, select Electrical work.

15. Right-click on the quoted amount for Architectural Design and select Award to award the work
to them.

16. Click Yes on the resulting prompt to mark the quote group as reviewed.
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LESSON 9 - REPORT ING

STEP BY STEP — GETTING TO THE REPORTS MENU

1. Open the Training Job, and select Setup tab.

l You access the Reports menu by clicking on the Reports icon

You can access the Reports menu from the Setup, Estimate, Quote, Price,
and Execution tabs.

2. Select Reports.

3. Here you select the Report of your choice. For this example, select the first option, Job
Properties.
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l You will see a split screen with the reports available on the left side bar

l The side bar on the left of the Reports form contains a “tree” of all InEight Estimate
adjustable reports
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l On the right, when you select a report node on the left, note that it displays the Output
Settings on the right side of the form, from which the report settings can be adjusted and
the report can then be run

4. Each report has a Print tab, a Layout tab and a Header/ Footer tab specific to that report.

l There are also Master Layout Settings and Master Header/Footer Settings located at the
bottom of the left-hand side bar tree. Here you can define settings that will apply to all
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reports
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STEP BY STEP — CONFIGURE REPORT OUTPUT SETTINGS (REPORT
1)

1. Open the Training Job and select Setup >Report>Resources.

2. Under Resources on the left side bar, select Resource Utilization.

3. On the Print tab there are three options. A best practice is to always set to Preview so you can
review before printing.
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4. On the Layout tab you can make adjustments based on your preferences.
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5. Move to the Header / Footer tab. Remove the default Report Title from the first page Header
only and enter Resource Utilization in the center Report Header box as a title that will appear on
the first page only.
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6. Go to the Details tab, and you can see the details and options you can select to customize and
adjust the report.

7. For this navigation, you will not Filter by currency; leave the selection as No Filter.

8. Under Report Type, choose the first option, Resource Utilization Summary.

l You can choose to select the Hide Zero quantity/cost Resources Employments Details box
if you prefer to have your printed report not show any resources that have a dollar value
of zero
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l You can choose if you want the report at a summary level, or if you want it to reference
your cost items when you are looking at a resource

l If you choose Resource Utilization Summary with Employed Cost Items, it adds CBS
position to the structure of the report

l You would select this if you wanted to see cost items and resources by the cost item

The Details settings are “sticky” features, meaning they default to what was
selected the last time.

9. You can use grouping to group by different tags and user-defined fields. Most of them are
related to the Resource Rate Register, for example: Geographic Area, Organizational Category,
Wage Zone, etc. For this example, group by Resource Organizational Category.

10. Next, you can choose the resources you want to see. For this example, select the Labor and
Construction Equipment Resource Types.
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l For this example, you will not make any selections under Columns or Details

l This is just one of many ways to organize and adjust your report.

11. Click Run to run the report.

l This report can be helpful for seeing your utilization hours, broken down by regular time
and overtime hours

12. Click the red X to close this page and open the Construction Equipment page.

13. Click the red X to close the Construction Equipment report.
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STEP BY STEP — CONFIGURE REPORT OUTPUT SETTINGS (REPORT
2)

1. Open the Training Job and select Setup >Reports, then expand the Cost Breakdown Structure
node.

2. Under Cost Breakdown Structure on the left side bar, select Estimate Summary.

InEight Inc.  |  Release 21.10 Page 95 of 200

Estimate Training Manual



3. Along with the Print, Details, Layout, and Header / Footer tabs, there is an additional tab called
Cost Item Selection. Select this tab.

4. The Cost Item Selection tab allows you to report on a selection of cost items:

l Print a contiguous range of cost items:  Allows you to print a series of cost items in a row.
In this case, print just items: select 4.1 in the From field and 4.3.2 in the To field.

l Select cost items to print from the register below:  Allows you to use column filters to
select the cost items to include in the report; leave this button unselected.

5. You can roll up your cost items to a certain CBS level for the report as well, depending on the
level of detail you need.

6. On the Details tab, select Days for Cost item production field 1, andMan-Hours / UM for Cost
item production field 2 (this report allows you to report on two production values).

7. Under Resource Types, uncheck all of the boxes except Labor, ConstructionEquipment, and
Installed Material.
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8. Leave the rest of the settings at their defaults, then select the Header / Footer tab.

9. In the center Page Footer field delete the existing text, then type Confidential –Internal Use
Only.

10. To save the settings you’ve configured, click on the Settings drop-down arrow above the output
setting tabs.
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11. Select the Save disk icon to save the new settings.

12. Type Estimate Summary – Manager.

13. Click OK.

l Notice that a custom version of the report now displays under Estimate Summary on the
Reports tree on the left
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STEP BY STEP — CREATE A REGISTER REPORT

1. Open the Training Job and select Setup tab, then select the Resource Rates drop-down list.

2. From the drop-down list, select Labor.

3. From your Saved Views drop down menu on the Resource Rate Register, select the Print View
for Summary view.
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4. Notice this view includes utilization hours

5. Right-click on a column header and select Column Chooser.

6. From the Customization window, drag-and-drop theMinority Percent, Unique Sales Tax, (Scale
2), andMaint. Man-Hour Factor columns into the register.

7. Close the Customize window.

8. Sort the Utilization Count column by clicking on the column header twice so that you see the
bars descending.
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l This sorts your items so the most utilized resources are at the top

9. Click on the Saved Views drop-down menu and select the Save disc icon to save the view.

10. Name the view Labor Utilization View, and then click OK to save the customized view.

11. From the Actionsmenu, select Preview to review the report before printing.
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LESSON 10 - DATA
REPRODUCT ION

STEP BY STEP — COPY AN EXISTING JOB

1. Click the File tab on the Estimate landing page.

2. From the left side panel, select New, then select Existing Job.

3. The Job Register displays a list of your existing projects; select the Training Job and click OK.

4. On the New Job dialog, click the ellipses and select a Core Project.

5. In the Code field, type Infra Job Copy with your initials.

6. To copy the cost details from the existing job to the new job, verify that the Copy Cost Details
checkbox is selected
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l If you wanted to copy just the cost item structure without cost details, you would uncheck
the box.

7. Uncheck the check for copying the PBS Changes Log, Copy Quotes and Auto-Update Job in
Connected Analytics.

8. Click OK to create the new job.

The new job opens with the Job Properties form active, so you can begin to modify the new job
as needed. If you look through the tabs on the Job Properties form, you will find that it looks
exactly like the job from which it was copied. Other forms, such as the Pay Item & Proposal
Register and the CBS Register, also look the same in both jobs until you make modifications in
one job or the other.

This is a very easy method for creating a new job, and it is a good choice if you want to copy an
entire job. However, if you want to pick and choose which parts of a job to duplicate, the Bid
Wizard is a better choice.
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STEP BY STEP — CREATE A TEMPLATE

1. Click the File tab on the Estimate landing page.

2. From the left side panel, select Templates.

3. Under Templates, select the Template Register.

4. From the Actions tab, select Create Template from Job.

l The Job Register opens for you to select the source job for the template

l Assume that you want to make a template from your E101 Training Job

5. Select the E101 Training Job with your initials, then click OK.
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You cannot create templates from jobs that are published to Job Tracking.

l The New Template From Job 'Training Job' with your initials prompt appears.

6. Click the ellipsis to the right of the Organization field.
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The Organization Register Library opens.

7. In the Organization Register Library, select an organization and then click OK.

8. In the Code field, type Small Project Template[your initials].

l Leave Copy Cost Details and Copy PBS Changes Log checked

9. Click OK.

l The new template is created and opens to the Job Properties form

l You can add the description in addition to the code for any new job you are creating from
a template. This description is later added to the Overview tab of the new job on the Job
Properties form

l Back in the Templates Register, you can see the new template created
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l Similar to copying an existing job, you can create a new job from a template
from the New menu in the Backstage View.

l You can also create a new job from a template from the New menu in the Bid
Wizard.

10. Select Add to existing job

11. From Select Source Job, click the dropdown arrow

12. Click Next

13. Select a job that is shown as having a Template

14. Click OK
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STEP BY STEP — ARCHIVE AND RESTORE A TEMPLATE

1. Click File to open the Backstage View.

2. Select Archive / Restore.

l Several options appear for archiving and restoring your jobs, templates, and library

3. Select Archive Template.

l The Template Register appears

4. Select the Small Project Template [your initials] template you previously made, then click OK.

5. When prompted to include attachments, click Yes.

l The Save As window appears

6. Browse to where you want to save the job, then click Save.

7. Select Restore Template from the Archive / Restore page of the Backstage View to begin
restoring the template.

8. Browse to the archived template and select it.

9. Click Open.

l If the template already exists, a prompt will appear asking if you want to overwrite it

l To overwrite it, select Yes

l If you select No, you will be prompted to save it under a new Template Code
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STEP BY STEP — USE THE BID WIZARD

1. To open the Bid Wizard, click the File tab on the Estimate landing page.

2. From the left side panel, select New, then select Bid Wizard.

l The Bid Wizard – Step 1 dialog displays
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Notice that you can either create a new project or add to an existing project.

3. Type E101 Bid Wizard (with your initials) in the New Code field.

4. Type Bid Wizard Example in the Description field.

5. Click the Next button.

l The Bid Wizard – Step 2 dialog displays

6. Choose Select cost items and click Next.

l The Bid Wizard – Step 3 of 4 dialog displays

l You use this step to indicate which source you want to pull your setup data from (the
library or your source job)

7. For all selections, select Copy from source job.

8. Check the Also copy all non-utilized resources checkbox.

9. Select Copy from source job under Unassigned Cost Items and Markup, and the Copy Markup
box is automatically selected.
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10. Click Next.

l The Bid Wizard – Step 4 of 4 dialog displays

11. Click the Source Job drop-down arrow.
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l The Job Register opens

12. Find and select Training Job.

13. Click OK.

l This screen displays the cost items of the source job (Training Job). All items are
automatically selected

14. Use the Toggle Include All button to exclude all selections.
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15. Select the checkboxes to includeMobilization, Clearing & Grubbing, and Unclassified
Excavation.

16. Notice that when selecting Unclassified Excavation, that cost item’s subordinates are
automatically selected
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17. Click Finish to add the new job.

l An Attention prompt appears asking, “Do you want to adjust Pay Rules and Shift
Arrangements of the copied cost items?”

l Typically, you will want to use the shifts and payment rules of your new destination job.

18. Select Adjust the pay rules and shift arrangements to match the destination.
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19. Click OK.

l A help bubble appears letting you know the job has been created, and that you can use
the ribbon tabs on the Estimate landing page to open any form

20. Close the help bubble by selecting the X in the upper right corner.

21. Open the Estimate > CBS to see the three cost items that were brought in.
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STEP BY STEP — COPY ESTIMATE DATA USING EDIT COMMANDS

1. Click the File tab from the Estimate landing page and open the E101 Bid Wizard job you just
created.

2. Open the Training Job (if you do not still have it open).

3. Make sure the CBS is open for both jobs by going to the Estimate menu and selecting Cost
Breakdown Structure (CBS).

4. Since you have both jobs open and they are in their own application window, align them to be
side by side by using theminimize icons of each job or utilizing Windows align functionality.
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l Note that the window caption identifies the CBS Register for each job

5. On the CBS of the Training Job, click the row header on cost item 4 – Aggregate Base and press
Ctrl+C to copy the cost item.

When you copy a superior cost item, all of its subordinates are automatically
copied.

6. On the CBS of the E101 Bid Wizard job, click the row header on the first blank register row, and
press Ctrl+V to paste the cost item.

7. On the Attention dialog, select Adjust the pay rules and shift arrangements to match the
destination and click OK.
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l You can see in the destination job’s CBS that you’ve added the Aggregate Base cost item,
along with its subordinate cost items and all cost and productivity detail

You can also drag and drop cost items from one CBS to another instead of
copying and pasting.

Copied cost items are considered Job Overhead until they are assigned to a
pay item

8. To go back to your full screen view of the E101 Bid Wizard job, select the maximize icon.
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STEP BY STEP — USE THE CBS BID WIZARD

1. Click the File tab from the Estimate landing page and open the E101 Bid Wizard job you created.

2. From the Estimate tab, select Cost Breakdown Structure (CBS).

3. Create a new cost item by typing New in the Description column on the bottom row of the CBS

4. Highlight the New row.

5. To open the CBS Bid Wizard, click the Bid Wizard icon on theMore Actions tab.

l The Bid Wizard window opens

6. Click in the Source Job column on the New cost item row.

7. From the Source Job drop-down list, select Training Job.

8. Scroll to the right of the Source Job column and click in the Source CBS Position Code column on
the New Cost item row.

l A source CBS Register window appears

9. Select CBS position code 5 – Asphalt Concrete Hot Mix Type A from the register.
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10. Click OK.

11. Click Finish on the Bid Wizard.

l An Attention prompt displays, asking if you want to make adjustments

l Keep the default options selected:Make Adjustments according to their quantity drivers
and cost drivers and Adjust the pay rules and shift arrangements to match the
destination

12. Click OK.

l You can see that cost item 5 and its subordinates are now imported into your existing job.

l You could choose a new name for the cost item, or name it Asphalt Concrete Hot Mix
Type A to match the original cost item
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STEP BY STEP — SNAPSHOT REGISTER

1. Click theFile tab to open the Backstage View. In the panel, select Snapshots.

2. From the Snapshots form, select the Snapshot Register tab.

3. To view individual snapshots for specific jobs, click the icon next to the desired job to display
the list of snapshots.
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STEP BY STEP — CREATE A NEW JOB SNAPSHOT

You can create a Job Snapshot from an existing Job.

1. From the Snapshots form, select the Create Snapshot tab.

2. If an existing job is open select Save, if you haven’t already done so.
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3. A New Job Snapshot [Job Code Here] dialog box appears. From there, you can add a Snapshot
comment.

l If you want to Include all Attachments that have been stored in the Job Folder with this
Snapshot, select the check box, otherwise uncheck the box.

l If you want to Use Job's current User Access restrictions for this Snapshot, select this radio
button.

l If you want to Remove User Access restrictions for this Snapshot and allow read-only
access to all users, select this radio button

l If you want to Specify User Access restrictions for this Snapshot (default selection), select
this option

l Then use the Add and Remove buttons to specify user access using Active Directory.
(Users with current access to the job default onto the list.)

4. Click OK to create the snapshot.

5. A pop-up indicates when the snapshot has been created.
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STEP BY STEP — EDIT A JOB SNAPSHOT

1. From the Snapshot Register, click the icon next to the desired job to display snapshots.

2. Right-click on the individual snapshot you want to edit and select Edit.

3. The same sort of dialog box opens up as when you created the Snapshot. In this case, from the
Edit Job Snapshot [Job Code Here] dialog box, modify the Snapshot Comment and the User
Access options as needed.

l If you want to Include all Attachments that have been stored in the Job Folder with this
Snapshot, select the check box. Otherwise, uncheck the box

l If you want to Use Job's current User Access restrictions for this Snapshot, select this radio
button

l If you want to Remove User Access restrictions for this Snapshot and allow read-only
access to all users, select this radio button

l If you want to Specify User Access restrictions for this Snapshot (default selection), select
this option

l Then use the Add and Remove buttons to specify user access using Active Directory.
(Users with current access to the job default onto the list.)

4. Click OK to update the snapshot.
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STEP BY STEP — DELETE A JOB SNAPSHOT

1. From the Snapshot Register, click the icon next to the desired job to display snapshots.

2. Right-click on the individual snapshot you want to delete snapshots from and select
Delete.

3. Click OK

Alternatively, you can delete all Job Snapshots by clicking Delete All Job Snapshots from the
Actions tab.
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STEP BY STEP — LOAD A JOB SNAPSHOT

1. Click the File tab to open the Backstage View, then select Snapshots.

2. From the Snapshots form, select the Snapshot Register tab.

3. On the Snapshot Register, click the icon next to the desired job to display the list of snapshots.

4. Right-click on the individual snapshot you want to load and select Load.

To identify a snapshot in Estimate as a read-only snapshot:

l The job name is preceded by the label SNAPSHOT: centered on the top of the toolbar

l A red banner shows the specific snapshot information at the bottom of the screen
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A snapshot can be modified, but it cannot be saved as it is read-only.
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LESSON 11 - SPREADSHEET
INTEGRAT ION

STEP BY STEP — EXPORT DATA TO AN EXCEL WORKBOOK

1. Open the Training Job and from the Estimate tab, open the CBS Register.

2. From the Actions tab, select Export to Excel.

3. On the Export spreadsheet to... dialog, browse to the location (folder) in your system where you
want to save the workbook, enter CBS Export in the File name field, and click Save.

l The workbook is saved to that location with the specified file name, and Excel
automatically launches and displays the workbook
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l Notice that the columns are formatted, with column headers and filtering turned on
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STEP BY STEP — CELL SELECT

1. Open the Training Job and from the Setup tab, open the Resource Rate Register.

2. Select the Labor tab.

3. Select Print View for Summary from your Saved Views drop-down menu.

4. From the top-right corner, select the Cell Select icon, (next to the Help icon). This puts you
in Cell Selectmode, so you can select cells to copy in the same way you would in Excel.

5. With the Cell Select icon active, highlight all information in the Description, Utilization Count
and Unit of Measurecolumns for all Labor resources.
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6. Right click on the selection and select Copy.

7. Open an Excel spreadsheet, right click in the A1 field and select Paste Special, choosing CSV as
the Source.

8. Click OK. The fields you copied from InEight Estimate paste into the spreadsheet.
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To turn off the Cell Select, simply click the Cell Select Icon again and it deselects
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STEP BY STEP — LINK ESTIMATE TO THE JOB'S WORKBOOK

1. Open the Training Job and from the Estimate tab, open the CBS Register.

2. For this example, create a new cost item in the blank row at the bottom of the CBS register and
name it Concrete Foundation.

3. Open the job’s workbook from the Estimate tab, by selecting theWorkbook icon.

4. In the job's embedded workbook, create a new worksheet named Concrete Take-off and enter
the following fields:

5. Create a new row to calculate the total cubic yards by factoring the length, width, and height
quantities.

l Your Volume Total should be 50 cubic yards

6. InEight Estimate will only link to named fields in the worksheet. Click in the field you want to
name (B6), then click in the Field Name window and type Volume.
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7. Go back to the CBS register and right click on the Concrete Foundation cost item Forecast (T/O)
Quantity field.

8. From the resulting right click menu, select Link this field to Workbook.

l You can also link the field by selecting the field and then selecting Link Field from the
Actions tab

9. On the Link to Workbook dialog, select the Update Estimate Field from Workbook radio button.

10. In the Field to link window, select Volume (you may need to click the Refresh button for the
field name to display).
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11. Click OK.

l The Forecast Quantity field for Concrete now is linked to the Volume field in the
worksheet and populates with the take-off quantity (50)
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LESSON 12 - SCHEDULE
INTEGRAT ION

STEP BY STEP — LOGIN OPTIONS TAB

1. On the Schedule > Login Options tab of Job Properties, select the Use these login settings radio
button.

l If pre-defined login settings were required, the Use pre-defined login settings radio button
would be selected instead

l The Instance will remain set to -Default-

l Database selection will be pmdb during training.

2. Type your user name in the User Name field.

3. Type your password into the Password field.

l You will have your own login settings specific to your company
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STEP BY STEP — SCHEDULE A COST ITEM IN INEIGHT ESTIMATE

1. In the Training Job, from the Estimate tab, select Cost Breakdown Structure.

2. In the Saved Views drop-down list, select Schedule Setup View.

l In the Scheduled column, you can select the checkbox for each cost item that you want to
schedule

l If a cost item has subordinate cost items below it, you will only be able to check the
superior cost item, which will automatically schedule the subordinate cost items along
with it

3. Select theMobilization, Clearing & Grubbing, and Unclassified Excavation cost items, then
press Tab.
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STEP BY STEP — SCHEDULE A GROUP OF COST ITEMS IN INEIGHT
ESTIMATE

1. In the Training Job, from the Estimate tab, select Cost Breakdown Structure.

2. From the Saved Views drop-down list, select Schedule Setup View.

l To schedule multiple cost items, you can highlight the row for each cost item that you
want to schedule, using the Shift and Ctrl keys to select multiple rows.

3. Select additional cost items 4-Aggregate base, 5- Asphalt Concrete Hot Mix, and 6- 36-inch RCP
Culvert Class.

To schedule all cost items, highlight the JOB row.

4. Right click on the selected rows and select Schedule Selection.

l On the Schedule Cost Items dialog, you can select whether or not you want to roll up the
selected cost items to a specific level of the CBS for scheduling purposes

5. Select Schedule selected cost items and their subordinates without rolling them up, then click
OK.
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l Your scheduled cost items will import into Primavera the next time you update Primavera
from InEight Estimate.
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STEP BY STEP — ROLL UP SCHEDULE

1. In the Training Job, from the Estimate tab select Cost Breakdown Structure.

2. From the Saved Views drop-down list, select Schedule Setup View.

l Review your cost items to decide which cost items need to be rolled up

3. Select the Roll Up Schedule checkbox on the Unclassified Excavation cost item.
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STEP BY STEP — UPDATE PRIMAVERA FROM INEIGHT ESTIMATE

1. From the Estimate tab, select Schedule>Update Primavera from InEight Estimate.

l The Update Primavera From Estimate dialog prompts you to indicate what data to update
to Primavera

2. Make sure Resources and Expenses are checked. Deselect Actuals (For Job Tracking purposes) if
auto selected, then click OK.
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l An Attention prompt appears, letting you know that the job has not been saved.

3. Click Yes to save the job before updating Primavera.

l A window appears that shows the progress of the data sync between InEight Estimate and
Primavera. Depending on the size of the job, this can take several minutes
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l When the window disappears, the update is complete

4. Open Primavera P6 (Project Management) client.

5. Log in to Primavera, using the same Username and Password that was entered on the Schedule >
Login Options tab in InEight Estimate Job Properties.
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6. In Primavera, open the project.
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7. In the Open Project dialog, expand the BID*BUILD folder.
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All projects created from InEight Estimate are created in the BID*BUILD folder by
default.

l Your available projects are sorted by their job names.

8. Select the Training Job (with your initials) so that it is highlighted, and then select Open.

l The WBS Layout displays for the project. You can see the breakdown structure imported
from InEight Estimate with durations, rolled up as specified by the Roll Up Schedule option
in InEight Estimate

l Initially, the start date for your activities is the start date defined on the Job Properties >
Cover Sheet tab (these will change as activity relationships are defined)

9. Select the Resources tab to see the resources that imported for each activity, with their
associated costs.
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STEP BY STEP — UPDATE INEIGHT ESTIMATE FROM PRIMAVERA

1. Open your version of the Training Job project in Primavera.

l In the real world, it is likely that you would have overlapping activities, or your activities
would occur out of order, however for this example you will link all activities from finish to
start

2. Highlight all of your activities from 1-Mobilization through 6.4-Backfill RCP Pipe.

3. Right click on one of the selected rows and select Link Selected Activities to create the Finish to
Start relationship.

l You may have to select the Relationship Lines button to show the linked activities in the
graph on the right side of the screen.

4. To schedule this new relationship, select the Schedule button (or press the F9 key).

5. On the Schedule Project window, keep the default settings and select the Schedule button.
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6. To update InEight Estimate with this change, go back to InEight Estimate and select Estimate tab.

7. Select Schedule>Update Estimate from Primavera.

8. On the Update InEight Estimate from Primavera prompt, keep the default Update the estimate
to stay in synch with the schedule selected, then click OK.
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9. On the Schedule Setup View, you can see the Start and Finish dates updated from Primavera.
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STEP BY STEP — SCHEDULE PLUG DAYS

1. Look at the Days (Duration driven) column in the CBS where it shows 4.65 days for Excavate-
Install-Backfill Pipe.

2. Make sure the Schedule Plug Days checkbox is selected on the Excavate-Install-Backfill Pipe
cost item, then enter a Plug Days duration for the number of days the item will be scheduled in
Primavera (7 days).

l This allows you to maintain your duration of 4.65 days in the estimate and 7 days in the
schedule.
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STEP BY STEP — UPDATE PRIMAVERA WITH INEIGHT ESTIMATE
CHANGES

1. In the Training Job from the Estimate tab, select Cost Breakdown Structure.

l In this scenario, there is a scope change for your Excavation requiring you to change all of
your quantities

2. Change the quantity in the Forecast (T/O) Quantity field in the CBS as specified below:

Quantity Change for Cost Item

CBS Code Description Old Quantity New Quantity

5 Asphalt Concrete Hot Mix Type A 35,000 25,000

l As you make your changes, take note of how your duration changes in the Days (Duration
driven) column for these items

l If prompted about changing Total or Unit Cost, select Change TOTAL cost, so that your unit
costs stay intact, then click OK.

3. From the Estimate tab, select Schedule>Update Primaverafrom InEight Estimate to send the
changed hours to Primavera.

l The Update Primavera From InEight Estimate dialog prompts you to indicate what data to
update to Primavera
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4. Make sure Resources and Expenses are checked, then select OK.

l A window appears that shows the progress of the data sync between InEight Estimate and
Primavera. Depending on the size of the job, this can take a few minutes
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l When the window disappears, the update is complete

5. Open Primavera (P6 Web Client).

6. Open the Training Job project.

7. On the Activities screen, compare the Planned Duration to the Days (Duration driven) in InEight
Estimate for Excavate-Install-Backfill Pipe.

l The Primavera scheduled duration should have changed from 4.65 days to 7 days to match
the updated duration in InEight Estimate for Excavate-Install-Backfill Pipe

l You will also notice a change in days for Excavation after changing the T/O Quantity in
InEight Estimate

8. To schedule this change in Primavera, select the Schedule button (or press the F9 key) and select
the Schedule button on the Schedule Project window.

9. Your start and finish dates are different now. In InEight Estimate, from the Estimate tab, select
Schedule>Update InEight Estimate from Primavera to update InEight Estimate with the new
dates.
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STEP BY STEP — SCHEDULE A COST ITEM IN INEIGHT ESTIMATE

1. In the Training Job, from the Estimate tab, select Cost Breakdown Structure.

2. In the Saved Views drop-down list, select Schedule Setup View.

l In the Scheduled column, you can select the checkbox for each cost item that you want to
schedule

l If a cost item has subordinate cost items below it, you will only be able to check the
superior cost item, which will automatically schedule the subordinate cost items along
with it

3. Select theMobilization, Clearing & Grubbing, and Unclassified Excavation cost items, then
press Tab.
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STEP BY STEP — SCHEDULE A GROUP OF COST ITEMS IN INEIGHT
ESTIMATE

1. In the Training Job, from the Estimate tab, select Cost Breakdown Structure.

2. From the Saved Views drop-down list, select Schedule Setup View.

l To schedule multiple cost items, you can highlight the row for each cost item that you
want to schedule, using the Shift and Ctrl keys to select multiple rows.

3. Select additional cost items 4-Aggregate base, 5- Asphalt Concrete Hot Mix, and 6- 36-inch RCP
Culvert Class.

To schedule all cost items, highlight the JOB row.

4. Right click on the selected rows and select Schedule Selection.

l On the Schedule Cost Items dialog, you can select whether or not you want to roll up the
selected cost items to a specific level of the CBS for scheduling purposes

5. Select Schedule selected cost items and their subordinates without rolling them up, then click
OK.
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l Your scheduled cost items will import into Primavera the next time you update Primavera
from InEight Estimate.
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STEP BY STEP — ROLL UP SCHEDULE

1. In the Training Job, from the Estimate tab select Cost Breakdown Structure.

2. From the Saved Views drop-down list, select Schedule Setup View.

l Review your cost items to decide which cost items need to be rolled up

3. Select the Roll Up Schedule checkbox on the Unclassified Excavation cost item.
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STEP BY STEP — UPDATE MS PROJECT FROM INEIGHT ESTIMATE

1. From the Estimate tab, select Schedule>Update Project from InEight Estimate.

l Your job automatically opens in Microsoft Project

l The Work Breakdown Structure Layout displays for the project

l You can see the breakdown structure imported from InEight Estimate with durations,
rolled up as specified by the Roll Up Schedule option in InEight Estimate

l Initially, the start date for your activities is the start date defined on the Job Properties >
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Cover Sheet tab (these will change as activity relationships are defined)
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STEP BY STEP — UPDATE INEIGHT ESTIMATE FROM MS PROJECT

1. Open your version of the Training Job project in Microsoft Project.

l In the real world, it is likely that you would have overlapping activities or your activities
would be out of order, however for this example you will link all activities from finish to
start

2. Click on the Link Tasks icon to link all activities.

l Ensure the Auto Schedule button is selected

3. To update InEight Estimate with this change, go back to InEight Estimate and from the Estimate
tab, select Schedule>Update InEight Estimate from Project.
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l On the Schedule Setup View, you can see the Start and Finish dates updated from MS
Project.
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STEP BY STEP — SCHEDULE PLUG DAYS

1. Look at the Days (Duration driven) column in the CBS where it shows 4.65 days for Excavate-
Install-Backfill Pipe.

2. Make sure the Schedule Plug Days checkbox is selected on the Excavate-Install-Backfill Pipe
cost item, then enter a Plug Days duration for the number of days the item will be scheduled in
Primavera (7 days).

l This allows you to maintain your duration of 4.65 days in the estimate and 7 days in the
schedule.

InEight Inc.  |  Release 21.10 Page 175 of 200

Estimate Training Manual



STEP BY STEP — UPDATE MS PROJECT WITH INEIGHT ESTIMATE
CHANGES

1. In the InEight Estimate Training Job, from the Estimate tab, select Cost Breakdown Structure.

l In this scenario, there is a scope change for your Excavation requiring you to change all of
your quantities

2. Change the quantity in the Forecast (T/O) Quantity field in the CBS as specified below.

Quantity Change for Cost Item

CBS Code Description Old Quantity New Quantity

5 Asphalt Concrete Hot Mix Type A 35,000 25,000

l As you make your changes, take note of how your duration changes in the Days (Duration
driven) column for these items.

l If prompted about changing Total or Unit Cost, select Change TOTAL cost, so that your unit
costs stay intact

3. From the Estimate tab, select Schedule>Update Projectfrom InEight Estimate to send the
changed hours to Microsoft Project.

4. Go back to the Training Job in Microsoft Project.

l The Microsoft Project scheduled duration should have changed from 4.65 days to 7 days to
match the updated duration in InEight Estimate for Excavate RCP Trench
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l You can also see that the days for Asphalt Concrete Hot Mix Type A and its subordinates
adjusted because you adjusted the Forecast T/O Quantity in InEight Estimate

5. Your Start and Finish dates are different now. In InEight Estimate, from the Estimate tab, select
Schedule >Update InEight Estimate from Project to update InEight Estimate with the new dates.
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LESSON 12 - CASH FLOW

STEP BY STEP — CASH FLOW OPTIONS SETUP

1. In the E101 – Training Job, from the Estimate tab, select Setup >Job Properties >Cash Flow.

l You will see the default options already there

l You will adjust a few of those options

2. Change your Revenue timing to Every month on the 10th.

l The average calendar days from billing to collection should be set to 25 days

3. For Cost timing, bills are received from subcontractors and vendors Every month on the 25th.

l Average calendar days elapsed from receipt of invoice to payment should be set to 30 days

4. For Cost of money, enter 10% for the Average annual interest rate paid to borrow money (when
cost exceeds revenue) and 2% for Average annual interest rate earned (when revenue exceeds
cost).
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5. Leave all remaining options as originally defaulted.
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STEP BY STEP — CASH FLOW DISPLAY SETTINGS SET UP

1. In the E101 – Training Job, from the Estimate tab, select Cash Flow from the Schedule section.

2. On the Actions tab, select Display Settings to open the Display Settings window.

3. From the Period drop-down list, selectWeek.

4. Under the Cost Items section, make sure the following are selected:

l Total Cost (Forecast)

l Total Price (Forecast)

l Total Cost (Forecast) – Cash

l Total Price (Forecast) – Cash

l Cash Flow
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l Finance Cost

5. Under the Cost Categories section, check the Estimated checkbox for the Labor and Owned
Equipment categories.
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6. Click OK to close the Display Settings window.

l Your Total Cost (Forecast) displays as a dashed red line, indicating your accrued costs
based on when your cost items are scheduled and the assigned cost curves for each cost
item.

l Your Total Price (current) displays as a dashed green line, indicating the revenue you’ve
earned, based on the timing of your pay items

l Your Total Cost (Forecast) – Cash displays as a solid red line, indicating your costs, based
on when your cost items are scheduled and the cost timing defined in Cash Flow Options

l Your Total Price (current) – Cash displays as a solid green line, indicating your revenue,
based on the timing of your pay items and the revenue timing defined in Cash Flow
Options

l Your Cash Flow displays grey bars indicating when your cash flow is negative or positive
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l Your Finance Cost displays as a blue line on the graph

7. To filter your graph by date range, click on the Start drop-down arrow and select a start date of
your date range filter.

8. Click on the End drop-down arrow and select an end date of your date range filter.
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l Your graph now only includes your cost items that fall within the specified date range

9. To remove the filter, click in the Start field and press the Backspace key.

10. Do the same for the End field.
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STEP BY STEP — RESOURCE UTILIZATION DISPLAY SETUP

1. In the E101 – Training Job, from the Estimate tab, select CashFlow from the Schedule section.

2. On the Actions tab, select Display Settings to open the Display Settings window.

3. Make sure the all checkboxes are unchecked under the Cost Items and Cost Categories sections.

4. Under the Resources section, check the Resource Utilization checkbox.

5. From the Summarize resources by drop-down list, select Description.

6. From the resulting list of Values, select Laborer.

7. Click in the Qty field for the selected value and select a color of your choice.

l In this case the Qty represents the work hours for your Laborer resource

8. Click in the Cost field for the selected value and select a different color of your choice.

9. From the Quantity and Cost drop down lists, you can select how your quantities and costs will
display on the graph. In this case select the Quantity to display as a Bar and Cost to display as a
Line.
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10. Click OK to close the Display Settings window.

l The graph now displays the utilization of your Laborer resource, showing the work hours
and costs used over time

The graphs displayed on the Cash Flow form are based on the estimated cost of each cost
item and its resource employments (in the case of resource utilization).
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LESSON 13 - HAUL CALCULATOR

STEP BY STEP — HAUL CALCULATOR – CALCULATE QUANTITY OF
TRUCKS

1. Open the Training Job and from the Estimate tab, select Cost Breakdown Structure.

2. Open cost item 4.1 – Furnish & Haul Base Material.

3. On the Cost Item Record, click the Detail tab.

4. Right click on the ETDT – Dump Truck row header and select Open Haul Calculator.

5. On the Haul Calculator, select the Calculate quantity of ETDT required to complete haul in
duration entered below radio button. (ETDT is the resource code for the Dump Truck you
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selected.)

6. For the Haul Distance, type 5.

7. Enter an Average Payload (Ton) of 30.

8. For Load Time (Minutes), type 3.

9. Enter a Travel Speed Full of 35Mile/Hour.

10. For Dump Time (Minutes), type 2.

11. Enter a Travel Speed Empty of 45 Mile/Hour. Notice this calculates a cycle time of 20.24.

12. Enter aWork Efficiency of 90 percent.
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l The calculator shows a result of 1.56 concurrent haulers

13. Click OK.
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14. Your cost item now shows a quantity of 1.56. Round up the Quantity to 2. Also, adjust the
Teamster Quantity to 2 (if needed).
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STEP BY STEP — HAUL CALCULATOR – CALCULATE TOTAL DURATION

1. Open the Training Job and from the Estimate tab, select Cost Breakdown Structure.

2. Open cost item 4.1 – Furnish & Haul Base Material.

3. On the Cost Item Record, click the Detail tab.

4. Change your Teamster and Dump Truck quantities back to 2 each.

5. Right click on the ETDT – Dump Truck row header and select Open Haul Calculator.

6. On the Haul Calculator, select the Calculate total duration of haul using quantity of ETDT
entered below radio button.

l With the previous information you entered still there, the calculator calculates a total
duration of 281.08 hours

7. Click OK.

l The Hours field on the Production tab updated to 281.08

l Your ETDT Dump Truck quantity remains at 2
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STEP BY STEP — TRENCH CALCULATOR – TRENCH

1. Open the Training Job and from the Estimate tab, select Cost Breakdown Structure.

2. Create a new cost item from the bottom row of your CBS and call it 24” Pipe.

3. Add the following three subordinates and update their Units of Measure:

l Excavate Trench: CY

l Install Pipe: LF

l Backfill Trench: CY

4. Open the Excavate Trench Cost Item Record. Add the following resources:

l LL2  Laborer – 1

l LO2  Operator Class 2 – 1

l EX245  Excavator 245 – 1

5. Adjust the Production to: 100 CY/Hour.

6. On the Cost Item Record’s Actions tab, select Trench Calculator.
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7. For Trench Length, type 1000.00 feet.

8. For Trench Width (at the bottom) type 4.00 feet.

9. Enter a Trench Depth of 10.00 feet.

10. Enter a Hinge Elevation of 5.00 feet.

11. Enter a Backslope of 45 degrees.

12. Define theMaterial Swell/Shrinkage Factor (fraction expressed as a decimal) at .10.

l You can select either a “neat-line” total volume or include swell/shrinkage

13. Select the “Total excavated volume (including swell/shrinkage)” checkbox.

14. Click Save Configuration to Library and save the Trench calculator as Trench Example with your
initials.

15. Click OK.
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STEP BY STEP — TRENCH CALCULATOR – PIPE

1. On the CBS Register, adjust the Forecast T/O Quantity for the Install Pipe cost item to 1000 LF.

l Assume this quantity is based off manual take-off calculations you already did

2. Open the Install Pipe Cost Item Record.

3. Add the Resource Assembly of CPIPE - Pipe Crew and adjust the production to 300 LF / Day.

4. On the Cost Item Record’s Actions tab, select Trench Calculator.

5. Select Load Configuration from Library.

6. Select Trench Example (with your initials).

7. Click OK.

8. On the Trench Calculator, select the Pipe tab.

9. Enter the following for the size and position of the pipe:

l Pipe exterior diameter:  26.00 inches

l Pipe center elevation (from bottom):  19.00 inches

l Waste factor: 10%

10. Click on the resource icon to pull up the Resource Rate Register.

11. Select the Installed Material tab.

12. SelectMPP24 Pipe 24” PVC SDR35, then click OK.

l The Pipe variables you entered should match the following image:
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13. Click Save Configuration to Library and save the Trench calculator as Trench Example with your
initials.

14. When prompted to overwrite the existing saved file, click Yes.

15. Click OK to close the Trench Calculator.
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STEP BY STEP — TRENCH CALCULATOR – BEDDINGS

1. Back on the CBS Register, adjust the Forecast T/O Quantity for Backfill Trench to 2300 CY, based
on manual calculations.

2. Open the Backfill Trench Cost Item Record.

3. Add the following resources:

l LL2 Laborer – 3

l LO2 Operator Class 2 – 1

l RPC Plate Compactor – 1 

l EL950 Loader 950 – 1

4. Adjust the Production to 160 CY/Day.

5. From the Cost Item Record’s Actions tab, select Trench Calculator.

6. Select Load Configuration from Library

7. Select Trench Example (with your initials), then click OK.

8. On the Trench Calculator, select the Beddings tab.

9. On the Beddings tab, you can define up to four beddings to backfill the trench

l The variables you enter will determine how much bedding you need

10. Enter the following variables for each bedding:

Bedding Lift 1 Bedding Lift 2 Bedding Lift 3

Elevation (from trench floor) 6.00 38.00 76.00

Additional material needed 5.00 5.00 5.00

Conversion factor 1.60 1.70 1.60

l Under Results, you can match each of the Bedding Lifts with a material resource, by
selecting the resource icon and selecting the resource you want to employ from the
Material tab

11. Selecting the resource from the Tons selection field, select the following materials for each
bedding:
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Resource Code Resource Description

Bedding Lift 1 MASAND Sand

Bedding Lift 2 MAFA Fine Aggregate

Bedding Lift 3 MACA1-1/2 Coarse Aggregate

12. Click OK.

l Note that the pipe and bedding materials are added to the cost item with their quantities
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STEP BY STEP — IN-FIELD CALCULATOR

1. Open the Training Job and from the Estimate tab, select Cost Breakdown Structure.

2. Scroll to find cost item 13.3 Sandblast.

3. Click in the Forecast (T/O) Quantity field.

4. Press the = key, then type 10*250.

5. Press the Tab key and it calculates the result.
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